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The following guide gives a description of the most commonly used features of MaX UC Mobile. 
Please refer to the installation instructions for information on downloading and launching the 
client. Please note that certain features like Meeting and SMS are add-on capabilities.  
 
MaX UC lets you make calls from anywhere using the most convenient device. Therefore, if you 
place a 911 call from MaX UC Communicator, the 911 operator may not be able to identify where 
you are calling from, thus this is not suggested for emergency use. 
 
Your account credentials are required to log into the application. The credentials are your 
telephone number and CommPortal password. If you do not have this information, please contact 
your system administrator or Telesystem directly.  
 
 

MaX UC Desktop Basics  
 

Logging In and Out 
 
You must be logged into the MaX UC desktop application to use its features.  
 

To launch the installed application, choose the application from the 
start menu or click on the associated desktop icon then enter your 
credentials when prompted.  While running, the MaX UC program may 
be minimized.  

 
 
From the File menu, you may Log Out or Quit.  

• Log Out- Log Out- stops the application from running. When you 
re-launch it next time, you will have to reinput your credentials. 

• Quit- stops the application from running. When you re-launch it 
next time, you will not have to reinput your credentials.  

 
 

Getting Acquainted with MaX UC Desktop 
 
The MaX UC interface allows you to make and take calls as well as send 
instant messages and manage collaborative meetings. It also shows the 
presence of your other colleagues that are using the application.  
 
Like other computer applications, simply point and click your cursor 
through the various sections and menus.  

 
 
  

 
This guide will highlight 

many benefits of the MaX 
UC client. If you are a 

Meeting user, please see the 
MaX Meeting guide for an 
explanation of all Meeting 

features! 

MaX UC: Unified Communications
Desktop User Guide Green Platform
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Profile and Settings 
 
Your profile appears on the top left of Max UC Desktop. This section allows you to personalize your account:  

• Click on the avatar circle to change or remove the current picture.  
• Use the status drop down to modify your 

presence or call manager features (more 
information on these in the Advanced section 
below)  

• Click the Online text box to personalize the 
message other MaX UC users see.  

 
Contacts 

 
Below your profile, you’ll notice three tabs for all your contacts and recent phone communication:  

• Favorites summarizes any contacts which you’ve marked as a “favorite” 
• Contacts automatically downloads all of your 

company extensions. This can also download your 
outlook contacts (more information on these in the 
Advanced section below). 

• Recent is a log of all of your most recent phone calls 
and chats.  

 
The contacts section is used to make calling and chatting with 
your colleges and customers quick and simple. Alternately, 
you can use the number text box above the tabs to manually 
type in a number or extension that is not already a contact.  
 
Presence  
 
MaX UC users monitor the presence of other MaX UC users in their business group when looking at the contact 
entry.  
 
Presence statuses on MaX UC Desktop include:  

 Available: user is available 

 In call: user is on at least one phone call 

 Do Not Disturb: user has enabled Do Not Disturb 

 Busy: user has changed presence status to busy 

 Outlook Busy: user outlook calendar reflects an event 

 Inactive: user has not been active recently (default is 15 minutes) 

 Offline: user is not logged into MaX UC or is not an MaX UC user  
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Making and Taking Calls  
 
Take a Call 
When MaX UC receives a call, a notification will show on the 
screen and a ringtone will play through the connected 
headset/speakers.  
 

• To answer the call, click Accept. If you were already on one call and answer a second, the other call will 
go on hold automatically. 

• To reject the call, click Reject. If voicemail is enabled on your line, the call will go to voicemail.  
 
 
Make a Call 
 
Call Using MaX UC Contacts: 

• Click the Contacts tab.  
• Scroll through the contacts or type in a search term to find the 

appropriate contact.  
• Hover over the contact name then click on the Call Contact button.  

 
 
Call Using MaX UC Dialpad: 

• Type in the phone number in the dialer field or click on the dialer to 
launch to keypad.  

• Press enter or click Call to initiate the call.  
 
Dialing *99 will access your own voicemail box and allow you to record a 
personalized greeting. 
 
 

In Call Features 
 
In Call Feature Screen 
 
While on a live phone call, the call screen appears. This screen will show you the caller ID information of the call 
and over a variety of features to use while on a phone call.   
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Conference/Add Call: You may add another call to an existing phone call. This allows all parties to speak with 
each other at the same time. To use, click this button, enter the phone number or extension you wish to join, 
the click Add to add the new caller to the existing call.  
 
Transfer: To send your current call to another destination, click this button, type in the phone number or 
extension you wish to send it to, then click Transfer to complete the transaction.  
 
Meeting: If the person you are talking to is also using MaX UC on the same network, you can uplift your audio 
call into a MaX Meeting collaboration session from an audio call with this button.  
 
Hold: click to hold and un-hold your current call.  
 
Video: add in video for 1-on-1 calls between you another MaX UC user within your enterprise (see the “About 
Video” section that follows) 
 
Mute: click to mute and un-mute your microphone.  
 
Volume: click to adjust your volume.  
 
Dial Pad: click to access the keypad.  
 
Switch: If you have other devices logged in as this phone number (for example, a deskphone or the mobile 
app), you may switch your currently active call to another device by clicking this button then answer on the 
other device. When the call is answered on another device, it will automatically end on the desktop.   
 
Record: Click to record your current call. Recordings are saved to your local computer drive by default. Be sure 
to follow all state, federal, or industry guidelines for recording and file retention.  
 
End a Call: click to hang up the current call.  
 

  About Video Calling 
                             Important notes about video calls:  

§ MaX UC users can uplift voice phone calls into a 1-on-1 video call with other MaX UC users in 
their own business group.  

§ Video calling is not available to users that have the iACD feature or automated call recording 
enabled on their line.  

§ This option requires that you’ve allowed the application permission to access your device 
camera(s).  

§ Please note that the available features during a video call will be curtailed (video call options do 
not include Add Call or Transfer).  

  

Chat (Instant Messaging and SMS)  
 
Chat (via Instant Message) 
 
MaX UC users may initiate chat with one or more MaX UC users in their business group.  
 
To initiate a chat session:  

• Search for the contact  
• Hover the cursor over the contact entry 
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• Click the chat icon  then enter a message to begin a chat 
 
Buttons that line the top of chat window will allow the user to do the following:  

 uplift the chat into a collaborative MaX Meeting 

 Send a file 

 View recent chat history 

 Call the contact 

 Add an additional person to the chat session 
 
Chat (via SMS) 
 
MaX UC users may send and receive SMS messages if the feature is enabled on the account. Usage charges may 
apply for SMS messages. Please contact your sales representative for details.  
 
If your MaX UC client has SMS capabilities enabled, you can send an SMS message to other SMS-enabled 
telephone numbers. For example, you can send an SMS (text) message to one of your clients’ cell phones.  
 
To send an SMS message to an existing contact:  

• Find the contact using search or one of the contact tabs. 

• Click the  chat icon to open the SMS/Chat box. 

• Ensure that SMS option is selected in the chat text box 
then send the message normally.  

 
To send an SMS message to an ad-hoc telephone number: 

• Input the telephone number of the contact in the dial field.  

• Click the  SMS icon to open the SMS/Chat box. 

• Ensure that SMS is selected in the chat text box then send the message normally. 
 
Please note that your direct dial phone number is the telephone number that the SMS recipient will see as the SMS 
sender (not your company’s main number).  

 

Advanced Features 

Voicemail 
See any/all messages by clicking on the  messages icon.  Any messages that are being sent to your 
CommPortal (phone) may be managed in the Messages screen that follows. If new messages are in your box, 
they are indicated as a number on the messages button. 
 
Call Pull 
 
The Switch feature is what you use when you are already on a phone call on MaX UC and want to resume it on 
another device. Alternately, if you are on a call on another device (for example, your desk phone), you may pull 
the call to the MaX UC Desktop application in order to continue it there.  
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To Pull a live phone call to Desktop MaX UC:  
 

• Click the   button in the MaX UC interface.  
• In the screen that appears, click Pull Call to continue the call on the Desktop application.  

 

Call Manager 

The Call Manager section allows you to modify your availability for 
calls. Please note that the changes you make to the call manager will 
apply to all instances of your phone number (for example, you may 
have a desk phone, desktop softphone, and a mobile softphone 
application).  

 
To modify the Call Manager settings:  

• Click on the arrow by the name of your phone to show the 
drop down menu 

• Hover over the call manager section then choose the menu 
option you would like to utilize.  

 
Available or Do Not Disturb 

• A checkmark by Available signals that you are ready to take calls to the phone number and extension 
assigned to your MaX UC Desktop login.  

• A checkmark by Do Not Disturb sends all of your calls directly to your voicemail. You may still make 
outbound calls normally.  

 
Allow Calls from the Priority Callers list 

• If you’ve chosen to put your phone into Do Not Disturb, you may choose to keep getting calls from your 
designated Priority Callers by placing a checkmark here.  

• Please note that you must create your desired list of priority callers by going to View All Settings and 
creating a list there. 

 
Ring account phone or Forward calls immediately 

• A checkmark by Ring Account Phone signals that you want all calls to ring the phone number assigned to 
your account.  

• A checkmark by Forward calls immediately allows you send all calls to an alternate phone number or 
extension.  

 
View all settings 

• Use this option to modify the above call manager settings and more.  
 
Call Park 
 
Call Park is a very popular feature of desk phones. To use call park in your Desktop application, you must first 
enable it. Navigate to Tools- Options- Calls- Enable call park. You will only need to do this once.  
 
After the call park is enabled, it may be used during a live call as follows:  
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To park a live call: 

• Click on the Call Park button in the call screen  
• Click on an available park to transfer the call to the 

orbit.  
To retrieve a parked call:  

• Navigate to Tools – Call Park.  
• Click on the parked call you wish to retrieve.  

 
Other Common Changes                                                                                                            

There are many options to explore in the MaX UC application.  

Other very common changes include: 
 

• Download your Outlook Contacts. Integrate your outlook contacts into MaX UC by going to Tools-
Options-General-Contacts-Use Contacts from- Outlook.  
 

• Use MaX UC desktop with a different phone. 
This is a very helpful option if you don’t have 
a microphone on your computer because it 
allows you to use MaX UC desktop to initiate 
calls using a different device such as your 
desk or even a cell phone. To configure, go to 
Tools-Options-Calls-Make Calls Using- Click to 
Dial-then enter an alternate number to use.  

 
• Turn off incoming calls completely. If you 

only want to receive chats and manage 
meetings via your app, you can turn off direct 
calling completely by going to Tools-Options-
Calls-Turn off Direct Calling. 
 

• Advanced Meeting Settings. You can modify 
your default MaX Meeting settings by clicking 
the Options tab then Meetings section.  

 

Meeting Tab 

If the Meetings feature is enabled, the Meetings tab will appear at the top of the MaX UC Desktop application. 
MaX Meeting allows the user to manage scheduled meetings, create new meetings, and join others.  
 
 
Schedule a Meeting 
 
MaX Meeting users can set up and a meeting that occurs right away or schedule a meeting in advance.  
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Ways to set up a meeting in MaX UC Desktop: 

• using the MaX Meeting Desktop Meetings menu (shown to the right) 
• from your Contacts list or while viewing a contact’s details 

• while chatting to a contact using instant messaging  

• when you are in a call  
 

 
Viewing Meetings 
 
You can view upcoming and recorded meetings via MaX Meeting Desktop. To do so from the application:  

• Select the Meetings tab 
• Choose Upcoming or Recorded Meetings 

 
From the Upcoming screen, you may start the selected meeting, delete it 
completely, edit the meeting details such as audio and video preferences, or 
copy to save the meeting invite details to your computer clipboard.  
 
The Recorded tab will show details and give access to recorded meetings. 
Recording files are saved locally to the MaX Meeting program file on your 
computer and thus only the recordings saved on your current machine will be 
shown in the list.  

 
Live Meeting Options 
 
While a meeting is in progress, you will see the host toolbar at the bottom of the Meeting window. 

 
Host toolbar: 

 
Audio and Video Options 

• Use the Microphone icon to toggle your microphone on  and off . 
• Select Join Audio to allow MaX Meeting to use either your phone or your computer’s microphone and 

speaker. 
• Select Leave Audio to prevent MaX Meeting from using your speaker and audio device. 
• Use the Video icon to toggle your video on  and off . 

 
 

Other Meeting Settings 
 
Click the arrow by the audio and video to modify the Settings for each.  
There you can set up and test your microphone, speakers, and video (if available).  
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Inviting Contacts During a Meeting 

Click   to select additional contacts you want to invite to join you in 
the meeting. Invite IM Contacts allows you to send an instant invitation to 
other users that are currently logged into MaX Meeting or Invite Others via 
an email or a URL link.  
 
 
 
View Meeting Participants  

Participants can select  to view the list of meeting attendees.  
 
The following options are available: 

• Mouse over your name to mute/unmute yourself or change your display name  
• Mute Me - put yourself on mute 
• Raise Hand - let the meeting host know you have something say. 

 

Meeting hosts can select  to access the Participants window. Use the Mute All or Unmute All 
options at the foot of the screen or Reclaim Host to take back the role of meeting host.  
 
Additionally, the More button gives access to the following:   

• Mute Participants on Entry - mute all attendees as they join the meeting. 
• Allow Participants to Mute/Unmute themselves- gives attendees to ability to mute or unmute 

themselves via the meeting software.  
• Play Enter/Exit Chime when a participant joins or leaves the meeting. 
• Lock/Unlock Meeting - no new attendees can join if the meeting is locked. 

 
The following icons provide additional information about each attendee. 

•    The participant is currently speaking. 

•    The participant’s microphone is on. 

•    The participant’s microphone is muted. 

•    The participant’s video camera is on. 

•    The participant’s video camera is off. 

• The participant has raised their hand. 
 
 
Screen Sharing 

Click  and choose the desktop or individual application window that you want to share or access the 
Advanced tap of the selection window to share only a portion of your screen or computer sound only.  
 
 
 
While sharing your screen with meeting participants, you will see the Screen Share toolbar: 
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The Screen Share toolbar provides the following options: 
• Mute - toggle your microphone on and off. 
• Stop/Start Video - toggle your video sharing on and off. 
• New Share - select a new window to share. 
• Pause/Resume screen sharing. 
• Annotate your shared screen using a variety of shapes and highlight tools, including: a Mouse; Draw 

options (lines, shapes, and arrows); a Spotlight tool; an Eraser to remove selected annotations; and 
Undo, Redo and Clear annotation options. 

• Note: The Annotate option may not be visible if the meeting host has selected to Disable Attendee 
Annotation. 

• Remote Control - as meeting host, take control of a participant’s screen 
• More - access settings for chat, audio, video, and participant annotation capabilities.  

 
Click  below the toolbar to exit screen sharing. 
 
 
Send a Message to Meeting Attendees 

Click  to open a chat window and send a message to a single attendee or the whole group. 
 
Click More – Save Chat in the window to save the conversation to your local computer.  
 
 
Record your Meeting 

Click  to start recording or   to pause or stop the meeting recording.  
 
When the meeting ends, the meeting recording will be converted to mp4 format and saved in a local 
directory. The file directory containing the saved recording will automatically open to show the recorded 
file.  
 
 
Leave the Meeting 

Click  to leave the meeting. 

If you are a meeting host, click  to end the meeting for all participants.   
 
 
Additional Meeting Window Options 

 extends the meeting display to a full screen display.  
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 exits the full screen display.  

 displays the video for all meeting participants.  

 displays the video for the current speaker.  
 
 
Download the Outlook Plugin 
 
An Outlook Plugin may be downloaded from within the MaX 
Meeting Desktop application. This plugin compliments the 
Meeting functionality by allowing the outlook user to easily 
schedule online meetings from within Outlook.  
 
To download the Outlook Plugin:  

• Click the Options menu 
• Click the Meetings Tab 
• Click Download Outlook Plugin button at the bottom of the screen 

 
The Outlook Plugin allows you to schedule Meetings directly from your outlook calendar instead of from the MaX 
application. If there are settings you want to apply to all meetings, note that all Advanced Settings can be set and 
managed from the application in Tools > Options > Meetings > Advanced Settings. 


